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One of the advantages of a multidetector neutron time-of-flight diffractometer such as the high
pressure preferred orientation diffractometer �HIPPO� at the Los Alamos Neutron Science Center is
the capability to measure efficiently preferred orientation of bulk materials. A routine experimental
method for measurements, both at ambient conditions, as well as high or low temperatures, has been
established. However, only recently has the complex data analysis been streamlined to make it
straightforward for a noninitiated user. Here, we describe the Rietveld texture analysis of HIPPO
data with the computer code Materials Analysis Using Diffraction �MAUD� as a step-by-step
procedure and illustrate it with a metamorphic quartz rock. Postprocessing of the results is described
and neutron diffraction results are compared with electron backscatter diffraction measurements on
the same sample. © 2010 International Centre for Diffraction Data. �DOI: 10.1154/1.3479004�
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I. INTRODUCTION

The orientation of crystals in a polycrystalline aggregate
�or texture� has a profound influence on physical properties,
most importantly, anisotropy of bulk properties which are a
function of anisotropic properties of single crystals and the
orientation distribution. Texture has long been studied in
metals as well as rocks �see Kocks et al. �2000� for details
and applications� and we assume that the reader is familiar
with the basic principles of texture analysis. Texture or crys-
tallographic preferred orientation describes the orientation of
crystallites of phases that compose a material relative to
sample coordinates with a three-dimensional �3D� statistical
orientation distribution function �ODF�. The ODF can be cal-
culated from measured pole figures of lattice planes �hkl�. In
the case of neutron TOF diffraction data the ODF is obtained
directly as described below, but for representation we will
use the more familiar pole figures, which have been calcu-
lated from the ODF. Textures are not only important for me-
chanical properties; they are also essential for crystal struc-
ture refinements and volume fraction estimates of aggregates
with preferred orientation.

Various techniques are used to determine texture, most
commonly X-ray, electron, and neutron diffraction �e.g.,
Wenk, 2006 and Wenk, 2011�. Neutron diffraction has
unique advantages for texture analysis because of high pen-
etration combined with comparably large beam spot sizes.
The information derived from the diffraction data is averaged
over a large volume �typically in the order of a cubic centi-
meter�; therefore, sampling statistically significant numbers
of grains even in coarse-grained aggregates and special
sample environments are possible. Time-of-flight �TOF� neu-
tron diffraction is increasingly used to record textures of bulk
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materials, providing the additional advantage of determining
textures of low symmetry phases �e.g., Brown et al., 2006;
Xie et al., 2003�, of composites with complex diffraction
patterns �e.g., Ivankina et al., 2005; Wenk et al., 2001�, or in
situ experiments at high/low temperature �e.g., Bhatta-
charyya et al., 2006; Lonardelli et al., 2007; McDaniel et al.,
2006; Wenk et al., 2007� and stress �Hartig et al., 2006�.
Since the Rietveld approach �Rietveld, 1969� is used to ex-
tract the texture information, it does not rely on single well-
resolved diffraction peaks, as pole figure gonio metersdo,
which are used for constant wavelength neutrons or X-rays.
Neutron diffraction is most efficient with multidetector spec-
trometers such as high pressure preferred orientation
�HIPPO� �at LANSCE, Los Alamos; Vogel et al., 2004;
Wenk et al., 2003�, GEM �at ISIS, U.K.; Day et al., 2004�, or
SKAT �at the Joint Institute for Nuclear Research, Russia;
Ullemeyer et al., 1998�, where each detector records a spec-
trum of crystals with lattice planes in reflection orientation.

It is not trivial to advance from diffraction spectra to
quantitative orientation distributions. The Rietveld method
�Rietveld, 1969�, as implemented in the General Structure
Analysis System �GSAS� �Larson and Von Dreele, 2004; Von
Dreele, 1997� and MAUD �Lutterotti et al., 1997�, has proved
to be a very powerful tool for texture analysis. Other Ri-
etveld softwares such as FULLPROF �Rodríguez-Carvajal,
1993� or RIETAN-FP �Izumi and Momma, 2007� do not con-
sider full texture analysis but merely offer corrections for
preferred orientation and are thus limited to crystal aggre-
gates with random orientation distributions or special cases
such as orientation of plate-shaped crystallites in powders
�Dollase, 1986�. Here, we are not addressing methods or im-
portant applications of neutron diffraction texture analysis
but focus specifically on the Rietveld method with MAUD, as
applied to HIPPO data, providing an efficient hands-on pro-
cedure. Apart from data input with the MAUD wizard �de-

scribed below�, the procedure is equally applicable to any
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other TOF neutron diffraction data that are available in GSAS

format. Also, the emphasis is on texture analysis, not on
crystal structure refinement, microstructure, or residual
stress.

MAUD is not restricted to neutron diffraction. It is used
from two-dimensional �2D� X-ray diffraction images �e.g.,
Lonardelli et al., 2005�, microstructural investigations �e.g.,
Lutterotti et al., 2004�, and X-ray crystal structure analysis
�e.g., Lutterotti and Bortolotti, 2005�. Therefore, there are
many options in MAUD that are not used for neutron diffrac-
tion texture analysis and this can make it overwhelming for
beginners.

MAUD is not yet an established package like GSAS but
constantly evolving, as new scientific applications require
expansion and modifications. It is not a black box where you
enter data and get results, and therefore it is not foolproof �no
reference to FULLPROF!�. For many applications there is no
simple procedure and the user has to be familiar with many
of the complexities. TOF neutron diffraction, one of the early
MAUD applications �Lutterotti et al., 1997�, is an exception
and here we want to guide a user with a step-by-step proce-
dure through data analysis that is applicable to most routine
samples, specifically for the LANSCE HIPPO diffractometer.
Do not use this procedure for other applications such as tex-
ture analysis from synchrotron diffraction images. It is as-
sumed that the reader is familiar with the general geometry
of HIPPO �e.g., Wenk et al., 2003�. We will discuss a few of
the many options that apply to neutron diffraction �especially
in Sec. VI�. MAUD is written in JAVA and works with any
operating system for which a Java implementation is avail-
able �WINDOWS, MAC OS X, LINUX, and UNIX�. For our dem-
onstration we use WINDOWS XP. It should be noted that due to
the complexity of the program and large data arrays, MAUD

requires large memory �1 Gbyte is sufficient for most cases�
and, while an analysis is running, users should refrain from
running many other procedures at the same time, especially
two simultaneous MAUD refinements.

We apply MAUD to determine the texture of a sample of
amphibolite facies metamorphic quartzite from the Bergell
Alps, measured in the HIPPO automatic sample changer Re-
iche and Vogel, 2010. The sample was roughly cylinder
shaped with 1 cm diameter and 1.25 cm height �Figure 1�.
The data files as well as an instrument parameter file with
information on instrument geometry can be downloaded
from MAUD websites �http://www.ing.unitn.it/~maud/
tutorial.html and http://eps.berkeley.edu/~wenk/TexturePage/
MAUD.htm�.

II. GETTING STARTED

When measuring textures, it is of critical importance to
know the orientation of the sample relative to the diffraction
instrument and thus the diffraction vectors relative to the
sample for all spectra. Obviously, it is equally important to
record and preserve the specimen orientation relative to the
investigated larger scale object, e.g., a rolled plate or geo-
logical formation. Samples need to be oriented and then
mounted in a systematic manner, for example, with an arrow
pointing to a reference notch in a HIPPO sample holder �Fig-
ure 1�. This yields the ODF and pole figures relative to the

sample coordinate system such as the cylinder axis and the
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arrow. Samples mounted on the sample holder’s aluminum
rod hang into the sample chamber with the aluminum
shielded by neutron absorbing cadmium. If the latter is not
applied properly, spurious peaks of aluminum would be ob-
served and an additional phase might have to be added to the
analysis.

For texture measurements with HIPPO, typically
720-3He-detector tubes, distributed over 30 detector panels
and arranged on three banks �150, 90, and, 40°2��, are used.
Individual detector tubes of a detector panel are first cor-
rected for variations in diffraction angle, then added �binned�
at LANSCE, and finally exported in GSAS format �.gda files�.
For very coarse-grained samples with poor grain statistics it
is advisable to inspect the raw binary data sets showing the
histograms from each individual tube. This allows us to de-
termine if the sample consists of only a few single grains and
in such cases statistical texture analysis does not apply. The
raw data are generally not distributed to users since the data
sets are very large ��25 Mbytes per run�. A software pro-
gram to inspect those data sets is ISAW, which is available
from the ORNL neutron portal at http://neutrons.ornl.gov/
portal/. In addition to the binned data, the instrument scien-
tist provides an instrument parameter file �.prm�, obtained by
measuring two standards �sample position and incident inten-
sity�, containing information about the geometry and calibra-
tion of the diffraction instrument.

The sample coordinate system in MAUD is defined by
three right-handed cartesian, x, y, and z, and corresponding
rotations, �, �, and �, in that order �Figure 2�a��. These
rotations are the MAUD defined as positive for clockwise ro-
tation �rotation axis pointing towards the viewer� and are the
same as those of a standard texture goniometer, which means
the rotation axes move when a rotation is applied. We will
later explain how to apply a � rotation of 90° to bring the
HIPPO sample holder rotation axis into the center of the pole
figure. After such a rotation around the neutron beam axis,

Figure 1. Cylinder of rock, marked with an arrow to indicate orientation,
mounted on a sample holder, with a characteristic notch.
the detectors plot on the pole figure as shown in Figure 2�b�.
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With the 30 detectors typically used for texture measure-
ments, HIPPO has a large pole-figure coverage. Figure 2�b�
displays the angular range that each detector panel views and
thus the resolution that we can expect �Matthies et al., 2005�.
In the data analysis we generally assume that detector data
are representative of a point in the center of the polygon
�Figure 2�c��. Note that the coverage pattern of Figure 2�c� is
rotated �61.7° around � versus Figure 2�b�. This is due to
an offset of the rotation around the vertical axis introduced
by the geometry of the HIPPO sample changer. Coverage
can be improved by rotating the sample about the vertical
axis into three or more different positions �Figure 2�d��.
Typical rotations in the sample changer, furnace, or cryostat
are �=0°, 4°, 67.5°, and 90°. Positive numbers assume that
rotations are counterclockwise.

Each measurement of a given orientation with HIPPO
takes between 1 and 60 min, depending on the volume and
complexity of the sample. Thus, with four rotations, a mea-
surement is done in less than 1 h for most samples. With the
automatic sample changer up to 16 samples can be measured
automatically, without operator interaction.

III. ENTERING DATA

1. Download the latest version of MAUD from the web
�http://www.ing.unitn.it/~maud/� and install it on your
computer in a separate directory. Be aware that MAUD is
being updated periodically. You also need a recent version

Figure 2. �a� Sample coordinate system in MAUD with three orthogonal axes
and corresponding rotations �, �, and �. �b� Pole figure coverage in the
HIPPO TOF diffractometer. Neutron beam enters from the top. The area of
each detector panel is displayed. Relative to Figure 2�a� the system has been
rotated 90° around � to bring the HIPPO rotation axis into the center of the
pole figure. �c� Initial orientation in sample changer ��=0°� with �offset=
−61.7°. �c� four rotations to improve coverage. Equal area projection.
of JAVA �version 6 or higher is preferred: http://
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java.sun.com/javase/downloads/index.jsp�. JAVA is not in-
stalled by default in the WINDOWS operating system and
the open source JAVA implementation preinstalled on most
LINUX distributions �e.g., UBUNTU� at present is not suit-
able to run MAUD �install the last SUN version from the
previous link�. Also, download the HIPPO demo data set
into your computer and store it in a separate directory.
Then start MAUD. If you start MAUD for the first time it
will ask you to accept the license and where to store ad-
ditional files. It is most convenient to have those in the
MAUD directory. The MAUD console window will output
information during the operation that can be useful to
identify problems.

2. The menu option “File→New→Hippo Wizard” opens a
window �Figure 3� that allows you to conveniently import
the experimental data and prepare them for the automatic
analysis.

3. In the Hippo Wizard window, input a title describing the
data set.

4. Select the parameter file that corresponds to your data by
clicking on the “Browse” button next to the “Choose cali-
bration file” field �for this demonstration we use
hippo_sc_050819_30panel.prm from the demo data�. Af-
ter defining the instrument parameter file, select data files
with the second browse button �for example, 14445.gda to
14448.gda�.

5. Assign each data file a rotation angle omega �for the test
sample: 0° for 14445.gda; 45° for 14446.gda; 67.5° for
14447.gda; and 90° for 14448.gda�. The bulk rotation,
“Omega offset” ��61.7°�, accounts for the HIPPO sample
changer oddity that the sample holder notch is displaced
from the incident beam direction at 0° rotation angle. Ap-
plying this rotation realigns the sample, with the arrow
pointing to the top in the reconstructed pole figures. Click
on each file again to verify that the angles were assigned
correctly.

6. Click “Next” and choose the d ranges to be considered for
each detector bank. This range depends on the number of
peaks in your patterns. For instance, if the maximum re-

Figure 3. HIPPO Wizard in MAUD to load instrument parameter file and data
files.
flection d spacing is at 2.3 Å, choose a maximum d spac-
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° det
ing of 2.5 Å since all data above this upper limit represent
only background. For this example, we use 1 to 2.75 Å.
Data at lower d spacings do not improve the analysis �in
this case� because of the large number of overlaps. Re-
stricting the range also speeds up the computation. Gen-
erally, you consider each bank and each rotation as a dif-
ferent instrument and refine instrumental parameters
accordingly—namely, the scaling factors and conversion
factors for TOF to d spacing �DIFC�. Hence, leave the
corresponding option in the dialog checked.

7. “Finish” the Wizard. This returns you to the main MAUD

page. Data are displayed either as average profile �Plot tab
panel on the right hand side of the main window� �Figure
4� or as a stack of all spectra for a given “Instrument”
�Plot2D tab panel� �Figure 5�. There are various options
for graphic displays: they can be selected in the main
menu “Graphic→Plot options” or in “Analysis
→Preferences.” For this presentation we use black and
white representation. For Plot this is in “Preferences” un-
der the “plot.black&white” key “true” and for Plot2D in
“Preferences” under the “Multiplot2D.grayscale” key
“true” �Preferences are in alphabetical order, first upper
case, then lower case�. In the menu “Graphic→Plot op-
tions” we choose “sqrt” for intensity scale �log 10 scales
are used mainly for reflectivity analysis plotting�. There
are various options for X scale, 2�, d spacing, or Q, de-
pending on the application. Background can be subtracted
or plotted separately �in Figures 4 and 5 we do not sub-
tract background�. Spectra can be displayed normalized

Figure 4. Main MAUD page with Plot display for 150
with the incident spectrum �“Calibration correction,” as
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defined in the instrument parameter file�; the refinement,
however, uses actual intensities. We can also select font
and font size.

8. You may now inspect your data using the “Plot2D” panel
and by clicking on each “Dataset.” Note the bottom �first�
spectrum of the 90° bank detectors has a much lower
intensity �Figure 5� due to partial shielding of tubes by the
sample changer and we may want to remove it from the
analysis. Edit the data set in the “Datasets” panel �“Edit–
Edit Object” or the “eye” shortcut in the middle of the
toolbar, just under “Special”�. On the window that opens
there is a variety of information about your data �Figure
6�. Editing “Diffraction Instrument” �press the “Edit” but-
ton in the instrument panel� displays details about the
experimental setup. In the case of TOF neutron diffrac-
tion, the HIPPO Wizard has already initialized all impor-
tant information �subwindow in Figure 6�. For other TOF
diffractometers you may have to modify some entries. On
the main window �Figure 6� you may modify the compu-
tation range or you can exclude some regions from the
spectrum. The units are d spacings for TOF neutron dif-
fraction �converted from TOF in the .gda file�, 2� for
angular dispersive experiments, and energy for energy
dispersive experiments. Choosing “Datafiles” opens a
window with the individual diffraction spectra, including
orientation angles �Figure 7�. The orientation angles are
initialized for HIPPO data by the HIPPO wizard. For
other instruments or other rotations in HIPPO, e.g. around
a horizontal axis instead of the vertical axis, the proper

ectors: enter the data sets and disable faulty spectra.
sample orientation angles need to be entered here. The
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angle � defines the azimuth angle of HIPPO detectors
around the incident beam for a given Bragg angle. To
exclude the first spectrum �14445.gda �9��, disable the
first spectrum on the list �No. 9� for all four 90° banks.
�Select the spectrum and click on the “Enabled” check
button to disable. By default each data set and datafile in
the data set is enabled.�

9. Next, click on the “Phases” tab and load phases. This can
either be done from a cif file which you have downloaded
from a database �such as the free COD database, contain-
ing more than 100’000 phases at present, http://
www.crystallography.net/, Grazulis et al. �2009�, or the
equally free Mineralogical Society of America database
http://rruff.geo.arizona.edu/AMS/amcsd.php, Downs and
Wallace-Hall, 2003� or access structures coming with the
MAUD installation in the file structures.mdb. Select from
the principal menu “Edit” and “Load phases from CIF
data base or file…” or click the left arrow icon in the
toolbar. You can create your own version of the struc-
tures.mdb file by exporting crystal information in MAUD

to it for further use �right arrow icon in the toolbar�. You
can also enter your own crystal structure information
�space group, lattice parameters, atomic coordinates, etc.�
using the “Add new object” in the menu for the “Phases”
tab and then the “Edit object” command. For this ex-
ample, use “Quartz” from the MAUD database �Figure 5�.
Looking at the structure data �with “Edit object”�, we see
that temperature factors B�=8�2Uiso� for Si and O are
zero. The reason is that the cif file contains anisotropic
temperature factors which are currently not loaded in

Figure 5. Main MAUD page with Plot2D display for 90° detectors: disable f
“structures.mdb” window is shown� and edit the sample.
MAUD from cif files. Zero is not realistic and we enter
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“1.0” for each instead. We will later refine the tempera-
ture factor but keep it the same for all atoms. Temperature
factors generally vary between 0.2 and 1.5 for most atoms
and crystal structures at ambient temperature. Also, note
that if we use the HIPPO wizard, automatically neutron
scattering lengths for natural isotope abundances of ele-
ments are applied. In case other isotopes are required,
they can be specified in the “Edit object” window under
the tab “Structure” by pressing on the button to select the
element type. In case more than one isotope is present and
not in natural abundances, enter each isotope as a separate
atom site with corresponding occupancies. If multiple
phases are present, repeat this step for each phase.

10. Edit each phase, and in the “Advanced Models” tab
check that “Le Bail” is the actual “Structure Factor Ex-
tractor” �this is the default for the HIPPO wizard�, then
choose E-WIMV as a texture method. Under the texture
options �press the “Options” button for the texture
method�, select an ODF resolution between 7.5° and
15°, which approximates the angular resolution of
HIPPO �Figure 2�b��. Here, we use 15°. You can also
impose sample symmetry after you verify that the data
warrant it and your sample is properly oriented; i.e., the
symmetry axis of a fiber symmetric texture is in the
center of the pole figures �no symmetry is imposed
here�. You can use the “Sample position” window �under
“Sample window” to reorient the sample with respect to
laboratory coordinates to ensure correct symmetry. Un-
der “E-WIMV Advanced Options” you can restrict the
number of reflections that are used in the texture refine-

spectra, such as the one at bottom �No. 9�, then enter phases �the database
aulty
ment either by intensity or by d spacing �we use defaults
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0., 0.�. �On the main window, in “Analysis-Options”
make sure to “Enable texture extraction” at “end of it-
eration” which is the default�.

11. If you need the sample rotation axis in the center of the
pole figure, edit the “Sample” and under “Sample posi-
tion” choose �=−90°. This orients the system such that
the sample changer rotation axis is perpendicular to the
plane of the pole figure. In the final pole figure �Figure
10� you are looking down on the sample hanging in
HIPPO, with the face of the sample glued to the holder
facing the viewer and the arrow pointing to the notch
located at 12 o’clock. To obtain pole figures viewing the
sample standing on the holder as shown in Figure 1 and

Figure 6. Data set window with options to edit “Diffraction Instrument”
Backgrounds, as well as changing Computation range.
the arrow pointing to the notch at 6 o’clock �the conven-
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tional setting�, the sample position angles need to be set
to �=−90° and 	=−180°. You can verify the relation
between instrument and pole figure coordinate system by
plotting the pole figure coverage at any time �in
“Graphic–Texture plot”�—the 90° detectors have a char-
acteristic gap for the HIPPO door, which allows us to
identify the direction of the incident beam. The imple-
mentation of the E-WIMV algorithm in MAUD �see be-
low� requires that for strong textures �pole densities
�10 multiples of a random distribution �m.r.d.��, the
strongest pole figure maxima to be preferably near the
center of the pole figure, otherwise the differences in
sampling density may result in artifacts. If a strong tex-

dow for HIPPO parameters is inserted�, Datafiles, Excluded regions, and
�Win
ture is observed after the first analysis with the strongest
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can
maxima on the rim of the pole figure, reorient the sample
accordingly in the “Sample” tab. Three rotations around
orthogonal axes are shown in Figure 2�a�. The first rota-
tion is �, second is �, and last one is �; all rotations are
clockwise. For polyphase materials you can enter initial
estimates of the volume fractions in the “Layers” dialog
of the “Sample” tab �default is equal weight fractions for
each contributing phase�. These volume fractions will
later be refined.

12. At this point, you should save your analysis in your data
directory �from main menu: “File→Save analysis as”�
as a “.par” file �we use Brg980-Quartzite.par�. Save the
analysis after each successful refinement cycle. Then
you may re-load the file later and choose “Analysis-
Compute Spectra” to re-initialize the values, e.g. for tex-
ture plotting, without the need of a full analysis. Now

Figure 7. Datafiles window which
you are ready to start the refinement.
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IV. RIETVELD REFINEMENT

During the least-squares refinement you may look at pa-
rameters, e.g., lattice parameters, on the parameter list panel
on the bottom of the main window. You can also view them
in “Phase” by selecting the corresponding phase object to
find the cell parameters. It is advised not to open the “Edit
phase” window during refinement. This may interfere with
the least-squares routine if you modify something. Even if
you modify nothing, it is important to close these frames
using the button on top of the window �on WINDOWS XP the
small button with an “X” in the title bar on the top right of
the window� and not using the “OK” button. The latter
changes or refreshes the parameters in midst of the refine-
ment and may cause the optimization routine to compute
wrong quantities and behave erratically.

For simple analyses/materials you can use an automated

be used to disable certain spectra.
procedure �and this is the case for our example�. Under the
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menu “Analysis” select “Wizard.” In the appearing window
choose “Texture Analysis” in the right panel and press the
button “Go!” You may watch the progress of the refinement
in the graphics window �Figures 4 and 5�. The automatic
procedure with the Wizard will refine the most important
parameters in four cycles. Select no more than five iterations
�this can be adjusted as the refinement proceeds with the
proper indexed scroll bar in the iteration output panel of the
main window�. To guarantee convergence, you may, at the
end, perform three to five additional iterations �selecting
from the menu “Analysis→Refinement”�.

The texture wizard works well for single-phase materials
and clearly defined compounds with a light/medium texture.
For complex materials you need to proceed in individual
steps using the menu “Analysis→Parameter List” and
specify manually the parameters to refine. You can also ini-
tially use the wizard to set up automatically the parameters
and adjust them later. To do this, in the wizard select the
cycle step you want to perform �left panel� and press the “Set
parameters” button instead of “Go!” Then open the param-
eter list window to manually select the parameters to be re-
fined. The parameter list is also displayed at the bottom of
the main window and by setting the “Status” of an individual
parameter to “Refined” it is allowed to vary. Using the
“Equal to” option constraints between parameters may be
introduced �e.g. atomic positions of atoms on shared sites are
forced to remain the same�.

If you do everything manually you may proceed as fol-
lows: fix all parameters first �using the corresponding button
“Analysis→Parameter List”�, then free backgrounds and
scale parameters �with corresponding buttons�, and then
close the parameter list window and perform a refinement
�“Analysis→Refine” in the main menu�. Next, add to the
refinement “Spectra Monitors→TOF Bank SF” �with the
buttons in the parameter list window� and finally “Texture,”
depending on how the procedure converges. Section VI will
discuss some of the options.

Be aware that the least-squares procedure refines many
parameters �over 1000 in many cases�. Most parameters are
complex nonlinear functions and the total model used to de-
scribe the experimental data and deviations from these data
is a surface with many subsidiary minima. If too many pa-
rameters are refined from unrealistic starting positions, then
the refinement may converge into subsidiary minima rather
than the true solution or lead to divergence. It is therefore
important to have starting parameters as close as possible to
the true solution. If necessary, parameters can be adjusted
manually. Use “Datasets” → “Datafiles”, select a spectrum
and “View.” With “Tools” → “Change parameter” you can
change parameters manually and immediately see the result.

Below we only consider the “Texture Wizard.” The
cycles for the automatic refinement of the texture are the
following:

Cycle 1: Refining the scale factors, background param-
eters, and phase fractions for multiphase systems. The cali-
brated incident intensity parameters �12 parameters� are di-
rectly loaded from the HIPPO calibration file and then kept
constant. A single scale factor is refined for each detector
panel, accounting for differences in detector efficiency or
varying attenuation along the path between sample and de-

tector. Backgrounds are expressed with a polynomial. Three
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background coefficients are refined for each bank �by default
only three background coefficients but more can be added�
and, in addition, two background coefficients for each pat-
tern �view in “Datasets—Datafiles—Additional param-
eters”�. After the cycle, the background starts to look reason-
able and so does the overall intensity �Figure 8�. Note that
the high-angle 150° bank detectors �Figure 8�a�� have a
much higher resolution, i.e., narrower peaks, than the 40°
bank �Figure 8�b��, but lower counting statistics, i.e., noisier
data. Texture is not yet reflected in the recalculated spectra
�top of Figure 9�a��. Also, the wavy line is not matched due
to mispositioning of the sample, which is particularly serious
for the 40° bank.

Cycle 2: In addition to the previous parameters, peak
positions are adjusted during this cycle by refining cell pa-
rameters and the conversion parameters for TOF to d spacing
conversion based on observed d spacings. This essentially
corrects for sample alignment problems which may originate
even from changes in position of the center of gravity of the
scattering power relative to the calibration material due to
changes in the scattering power of the material. The wavi-
ness is corrected �Figure 9�b��.

Cycle 3: The microstructural parameters �crystallite size
and microstrains� are added to the refinement to adjust peak
shapes. There are several methods to refine crystallite size
and lattice strain �see also Sec. VI�. In this example we use a
simple isotropic model, which is the default. Only one over-

Figure 8. The fitting of scale factors and backgrounds for �a� 150° and �b�
40° bank average spectra �cycle 1�. Note the much higher angular resolution
of the high-angle detector, but poorer counting statistics. Spectra are not
normalized.
all temperature factor, B, is used for all atoms of all phases to

290Wenk, Lutterotti, and Vogel



avoid correlations and minimize possible errors. Other struc-
tural parameters, such as atomic coordinates, are not refined
with the texture wizard. You may refine them separately at
the end, including individual isotropic temperature factors,
but this requires excellent resolution and counting statistics.

Cycle 4: The orientation distribution is refined with the
chosen texture extraction method, in our example the
E-WIMV algorithm �Matthies and Vinel, 1982; more options

Figure 9. Texture Wizard with multiplots illustrating refinement stages in �a�
cycle 1, �b� cycle 2, and �c� cycle 4 for 40° detectors of �16.7 rotation. Top
calculated; bottom observed.
are briefly discussed in Sec. VI�. Intensities of individual
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peaks start to match �Figure 9�c��. Warning: the interactive
Plot2D display only shows the real calculated pattern at the
end of each cycle. In between it may indicate a perfect
match, but this is due to temporary fitting by the Le Bail
extraction, not true texture intensities.

The procedure with the Wizard does not automatically
refine all possible parameters for all phases. For example,
crystallite size and microstrains are not refined for phases
that are below a certain threshold. The default threshold
�0.001� can be changed in “Analysis→Preferences” “wiz-
ard.riet_refine_sizestrain_over” key.

After this refinement, several checks need to be per-
formed. The overall quality of the least-squares refinement is
expressed in R or Rwp factors, with 5% to 15% for a good fit.
These numbers are also included in the file generated by
“Analysis→Results.” There are separate R factors for tex-
ture and overall refinement because the WIMV and E-WIMV
methods use their own algorithms to fit the experimental
texture data extracted with the modified Le Bail procedure
�Matthies et al., 1997�. However, R factors are only a bulk
measure �e.g., Toby, 2006� and do not provide details about
potential problems. Refining more parameters may provide a
better fit �lower R factors� but adding parameters is only
justified if these parameters are constrained by the actual
data. The best evaluation of a satisfactory refinement is to
compare observed �bottom� and calculated �top� intensities
for all detectors on the multiplots �“Plot2D,” Figure 9�c��. In
the “Datasets” editing window under “Datafiles” select the
spectra, one or more at time, and press the “View” button to
get a closer look at observed and calculated intensity spectra.
The “Plot” panel on the main window can be misleading for
evaluating the fit. It is a simple average over all spectra for a
data set and does not take complex texture relationships into
account.

If the results appear reasonable, close all windows, ex-
cept the main window, then select “Graphic→Texture Plot”
to display the checked pole figures �Figure 10�. “Recon-
structed intensity” shows pole figures of selected lattice
planes hkl calculated from the ODF. “Experimental inten-
sity” displays normalized Le Bail factors. In this window
you can also confirm that you have the correct “Pole figure
coverage” �Figure 2�d��. Particularly for texture publications
we generally prefer gray shades for density mapping �click
“Gray shaded” on “Texture plotting” page�. Colors may be
more glamorous for presentations, but, if colored pole figures
are copied on a black-white printer, the pole densities be-
come unintelligible, with both minima and maxima appear-
ing dark. More details about texture representation are given
in Sec. VI.

The Wizard refinement is often sufficient to capture the
main texture features. You may wish to continue to refine
additional parameters from the many possibilities offered by
MAUD. They include lattice parameters for accessory phases,
atomic coordinates, temperature factors, anisotropic grain
size, and residual stresses. This can be done in “Analysis
→Parameter List,” fixing the ones you do not want to refine
and refining those you do by selecting them in the list and
changing their status to “Refinable.” Otherwise, you can edit
the individual parameters in the individual edit windows �for
phases, data sets, instruments, and sample�, and select them

to refine �by pressing the right mouse button when over any
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of the parameter text fields�. Be aware that the refinement is
limited by the quality of the data. For TOF neutron diffrac-
tion there is some inherent uncertainty about the sample po-
sition and correspondingly absolute lattice parameter values.
Also, for HIPPO peak resolution, even for 150° detectors, is
not extreme and thus information, e.g., on residual strain
may not be possible to extract.

V. EXPORTING TEXTURE DATA

For further processing of the texture data, the ODF can
be exported as an ASCII file �in the E-WIMV options win-
dow� in BEARTEX format �.mod� �Wenk et al., 1998�. ODF
densities in m.r.d. are interpolated for 5° 
5° cells.
Then, in BEARTEX �http://eps.berkeley.edu/~wenk/
TexturePage/beartex.htm� the MAUD format is first converted
to the standard binary format in routine CMAU. Subse-
quently, it is smoothed to alleviate the rigid cell structure by
applying a 7.5° Gauss filter �SMOO�. With this smoothed
ODF you can then calculate pole figures �PCAL� and plot
them as shown in Figure 11�a� �PING� in a format that is
preferred for publications. From the continuous ODF
weighted individual orientations can be generated for use in
polycrystal plasticity simulations �ODFW�. Also, you can
use this ODF to calculate polycrystal physical properties
�TENS�. In CSEC you can rotate the sample coordinate sys-

Figure 10. Texture plot window and selected 011, 101, and 003 pole figures
bottom.
tem.
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As a comparison, we analyzed the same quartzite sample
with the scanning electron microscope using the electron
back-scattered diffraction �EBSD� method. For EBSD, 5824
orientations were used, then smoothing the ODF with a 15°
filter and rotating the EBSD-ODF to get it into the same
orientation as the neutron pole figures �Figure 8�b��. The two
sets of pole figures are similar, including pole densities, but
EBSD data that rely on much smaller numbers of grains
show stochastic effects and are statistically less relevant
�Matthies and Wagner, 1996; Matthies et al., 2005�, under-
lining the main advantage of neutron texture analysis.

An interesting feature of this quartz texture is that 101
poles align perpendicular to the schistosity �center of the
pole figure�. Mechanical twinning causes this feature and the
pattern can be used as a paleopiezometer to unravel the stress
history �Wenk et al., 2006�. Also, in the resolution of positive
�101� and negative rhombs �011�, which are required for
such analysis, neutron diffraction excels over EBSD. With
EBSD some of the pseudohexagonal orientations that define
the trigonal symmetry may be misindexed.

VI. DISCUSSION OF SOME OPTIONS

In this section we are discussing some options for ad-
vanced MAUD users.

lot. The actual plot of pole figures �reconstructed intensity� is shown at the
to p
�a� We have already mentioned the “Preferences” ASCII file.

292Wenk, Lutterotti, and Vogel



Defaults are generally appropriate but occasionally you may
want to change them. The “Preferences.Maud” file is stored
in the MAUD directory and any changes will be applied per-
manently. Below are some keys for preferences that you
might want to change:

Multiplot2D.grayscale �default is false�: controls the
2D plotting in colors or B/W

log_output.fullResults �default is false�: generate long
or short listing log output

plotExpPF.minimumDistanceDeg �default is 10�: in
the experimental pole figure plot, control how far
from measured point the interpolation goes

wizard.riet_remove_phases_under �default is 0.01�:
remove automatically phases from refinements when
below 1% volume fraction �these are set to zero�.

�b� Where are the results? Results �with standard deviations�
are stored in the parameter list �on main MAUD page�. They
are also contained in the ASCII file “Results” with informa-
tion about the refinement as well as a reflection list with
intensity, size and strain information, and texture. This file is
written as a “lst” file in the directory of parameter and data
files. For E-WIMV the “lst” file contains normalized pole
densities for all ODF cells in gamma sections.

Parameters, including errors, can also be exported as an
ASCII file that can later be processed by EXCEL, etc. In
“File,” choose “Append Simple Results to…” or “Append
Results to.…” For “Append Simple Results” first create an
empty text file in your data directory. For “Append Results”
you also need to create a text file, but in this case it will only
write parameters for which, in the parameter list, the option
for “Output” has been set to “true.” By default all are set to
“false.”

�c� Background options. Two types of background are re-
fined. One is for each detector and one for each spectrum.
For the detector background there are various options. Often
a polynomial is used. It is not advisable to use more than
four coefficients �default with the HIPPO wizard is 3�. Alter-
natively backgrounds can be interpolated between manually
set values or points chosen automatically by the routine �us-
ing the method described by Sonneveld and Visser �1975� in

Sec. III�. MAUD does not interpolate the background on the
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experimental pattern, but to avoid using peak intensities as
background, it computes the interpolation on the experimen-
tal pattern after subtraction of the intensities due to phase
reflections. This way the choice of the points becomes less
important. Background functions for each spectrum are
added in “Datafiles→Additional parameter” and two coeffi-
cients are generally sufficient. In most cases the defaults of
the HIPPO wizard are adequate and the user does not have to
worry about it. For interpolated backgrounds there is a spe-
cific tab panel next to the one for the polynomial general
background in the data set editing window. Manual points
can be chosen graphically in the plot.

�d� Texture models. There are various texture models imple-
mented in MAUD �“Phases→Advanced Models→Texture”�.
This is not the place to discuss texture analysis in detail and
we refer to standard texts �e.g., Kocks et al., 2000; Matthies
et al., 2005�. Some methods are in direct space �WIMV,
E-WIMV, and ideal components�. There is also the option to
use the harmonic method which works in Fourier space. For
most applications the E-WIMV method is preferred. The
main options are the cell size �generally between 5 and 15�
and sample symmetry. However, sample symmetry should
only be imposed after it has been verified that it statistically
exists and the sample has been properly oriented �fiber sym-
metry around center of pole figures, orthorhombic symmetry
with horizontal and vertical symmetry axes, etc.�. The cell
size depends to some extent on the pole figure coverage by
data. In order to provide a solution, each ODF cell must be
covered by at least one data point �and preferably more�, i.e.,
the coverage must be 100%. On the E-WIMV option panel
the ODF hits can be viewed �at least one hit per cell� as well
as ODF weights which are interpolated, taking neighboring
cells into account. If the coverage is less than 100%, either
the cell size must be increased or more data need to be added
�e.g., larger d range� or a method such as harmonic or ideal
components must be applied. The texture refinement relies
on the Le Bail factors �Le Bail et al., 1988�, i.e., the fraction
of the experimental intensity and the structure factor with no
texture present. In the “E-WIMV→Advanced Options”
panel weak reflections can be excluded from the texture cal-
culation. This is useful to avoid artifacts.

Figure 11. Pole figures of c axes �001� and positive
�101� and negative rhombs �011� of trigonal quartz, re-
calculated from the ODF and plotted with BEARTEX for
publication quality. HIPPO data �top� and EBSD data
�bottom� for the same sample. Equal area projection,
upper hemisphere.
�e� Texture representation. All texture analyses rely on the
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ODF which is a 3D function describing the crystal orienta-
tion frequency of crystallite orientations represented in
sample coordinates. The latter is done with the Euler angles
and there are various conventions such as �1 ,� ,�2 �Bunge,
1965�, � ,� , �Roe, 1965� with =�1−90°, �=�, and
�=�2+90°. MAUD uses the formulation �, �, and � of Mat-
thies and Vinel �1982� that is identical to Roe. The overall
texture strength can be evaluated with the Texture Index F2
�Bunge, 1982�, but a more satisfactory representation is the
3D ODF which can be viewed in rectangular coordinates or
in less distorted cylindrical coordinates �Wenk and Kocks,
1987�. Often textures are represented as pole figures �in
sample coordinates for one crystal lattice plane normal �hkl�
or symmetrically equivalent sets �hkl�� or inverse pole fig-
ures �in crystal coordinates for one sample direction� which
are 2D projections of the ODF. These graphic representations
are available in “Graphic→Texture plot” and there are vari-
ous options. Note that all pole densities �ODFs as well as
pole figures� are normalized to express densities as m.r.d.
The “Texture plotting” routine allows us to plot ODFs, pole
figure coverage, reconstructed pole figures, and experimental
intensity �in “Preferences” “plotExpPF.minimumDis-
tanceDeg,” the range of interpolation can be set �default is
10��. The pole figure coordinate system depends on how the
sample has been mounted in the diffractometer and how
“Sample position” has been set. For inverse pole figures
�001� is in the center and the pole to �100� to the right. Three
inverse pole figures are plotted for normal direction �ND�,
rolling direction �RD�, and transverse direction �TD�. ND is
normal to the pole figure �z in Figure 2�a��, RD is pointing
vertically �x in Figure 2�a��, and TD horizontally �y in Figure
2�a��. Often ODFs and pole figures are exported as ASCII
files for further processing in other programs.

�f� Line broadening is convoluted by two terms: instrument
and sample broadenings. The first one depends on instrument
setup �only slightly on sample dimension and transparency�
and can be kept constant as it was determined during the
instrument calibration. Instead the second part of the broad-
ening can be different for each phase and in MAUD is the only
broadening that should be refined during an analysis. This
simplifies the refinement for the HIPPO user, as he will only
refine two parameters �crystallites and microstrain mean
value� for each phase instead of refining all Caglioti param-
eters for each phase �Caglioti et al., 1958; Caglioti et al.,
1960�. The instrument broadening is described by the for-
mula for the TOF profile function as described in the GSAS

manual �Larson and Von Dreele, 2004� and is loaded directly
with the instrument parameter file.

For the microstructural broadening there are different op-
tions available in MAUD. The default model uses two param-
eters �mean crystallites and microstrain “Delft” method� for
isotropic broadening �Eqs. 6 and 7 of Lutterotti and Scardi
�1990��. If one phase exhibits anisotropic broadening the
method of Popa �1998� can be selected where the crystallite
and microstrain anisotropy is described by a harmonic ex-
pansion and the crystallographic symmetries are imposed
through the Laue group of the phase. The best fit with the
smaller expansion should be pursued. Another model for an-
isotropic broadening is the “anisotropic–no rules.” The
method is described by Lutterotti and Scardi �1992�. In this

model crystallographic symmetries should be imposed simi-
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larly to what is done for anisotropic temperature factors us-
ing the point symmetry. The last model available can use
both the isotropic or anisotropic model but instead define a
different way to compute the peak profile and to convolute
crystallite and microstrain effects. It is called “distributions”
and instead of a defined profile function it computes the peak
shape from Fourier transforms of the convoluted crystallites
and microstrain distributions. The crystallite distributions
employed are described by Popa and Balzar �2002� and the
microstrain distribution was used by Lutterotti and Scardi
�1992�. It is composed of two terms: a mean microstrain and
a “slope” coefficient to account for dislocations or defects
distributed inside the grain or at the grain boundary.

When revising the results for anisotropic broadening, in
general do not rely on 3D grain shape representation �when
available� but rather on the size in different lattice directions
hkl �under “Results”�. For microstrain refinement, a medium
large d range is required. MAUD can be used to refine struc-
tural features of amorphous materials as described by Lut-
terotti et al. �1998�. For planar defects additional models can
be selected from the Warren description of planar faulting to
a single layer model for turbostratic disorder �Lutterotti et
al., 2010�.
Be aware that neutron diffraction data may not have suffi-
cient resolution to refine rms microstrain and particle size
and generally no attempt should be made to refine those
parameters, even if R factors improve.

�g� Absorption. One of the advantages of neutrons is that for
most materials there is excellent penetration and absorption
is minimal. However, there are cases where absorption needs
to be considered, e.g., in the analysis of texture in silver
coins with a very high neutron absorption �Xie et al., 2004�.
The shape can be entered in “Sample” “Sample Dimensions”
“Shape model.” The “Harmonic integration” is slow since it
divides the sample into discrete cells and evaluates corre-
sponding ray paths. The “Harmonic coefficient” method is
much faster and uses a simple approximation.
From the point of view of the user interface the two methods
provide a similar panel and parameters. The only difference
is that in “Harmonic integration” there is an additional field
to control the number of divisions for the integration path
and we just describe the “Harmonic coefficient” one. The
model uses the same description of sample shape as the Popa
model �Popa, 1998� to describe the anisotropic crystallite
size. In analogy to that method, the user needs to choose the
Laue group for the sample shape symmetry and the maxi-
mum harmonic expansion term �Lmax�. Lmax should be the
minimum number that permits to describe sufficiently the
absorption by the sample. We point out that especially for the
“Harmonic coefficient” model, due to the approximations
used, the goal is not to get the real shape of the sample but
the best correction for the absorption. Shape may not corre-
spond to the real one. Other options are needed to provide
sufficient flexibility for the model to work in different con-
ditions. Sample orientation angles permit to rotate the coor-
dinate system for the absorption correction. This way the
symmetry of sample shape/absorption can be decoupled from
the texture sample symmetries. The velocity absorption cor-

rection should be enabled for TOF experiments. The last two
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parameters are the model weight and the standard size. The
first controls the weight between absorption in reflection and
in transmission.

The model in its approximation considers two different
paths inside the sample. The first path connects the center of
the sample with the two points intersecting the incident and
diffracted beams with the sample surface �only a line passing
through the center is considered for computing speed rea-
sons�. The second path connects directly these two points. In
reflection the first path is long and the second is short. In
transmission both are long. Weighting between the two paths
permits to refine a balance between transmission or reflection
modes. We have found that a good starting value is 0.3 and
the parameter should be refined only towards the end of the
refinement if necessary. The last parameter �Standard size� is
just a commodity value to speed up convergence. We have
found that changing the overall size of the sample shape
changes the overall intensity of the diffraction a lot, much
more than any other parameter. In practice this prevents an
effective refinement of the sample dimension and shape or
the change in their parameters is very slow. The “Standard
size” parameter normalizes the sample dimension by its
value. So the program can change more quickly the sample
shape coefficients counterbalancing the change in shape di-
mension by refining also this size normalization value to
keep the same overall intensity. Therefore, this standard size
parameter should be refined along with the harmonic coeffi-
cients. Absorption pole figures can be plotted from the tex-
ture plot window. This absorption model has been used in the
past efficiently in cases of irregular shapes �Artioli et al.,
2003; Xie et al., 2004; Volz et al., 2006�.

�h� For multiphase materials, the contribution of individual
phases to the diffraction pattern in the “Plot” representation
can be evaluated by right clicking on the phase label in the
plot. It will show different phases with different colors.

�i� Magnetic scattering. At present only a simple “cone
model” �Hastings and Corliss, 1962� is implemented. One of
the advantages of neutrons is that they are sensitive to mag-
netic scattering and can be used to determine magnetic pole
figures �Birsan et al., 1996; Brockhouse, 1953; Bunge,
1989�.

VII. CONCLUSION

Quantitative texture analysis is of critical importance to
evaluate deformation processes both of man-made as well as
natural materials. It is also the basis for determining aniso-
tropic physical properties of polycrystalline aggregates.
Since crystallite orientation affects diffraction intensities,
consideration of texture is also crucial for evaluating volume
fractions and for crystal structure refinements of materials
that have preferred orientation. The Rietveld texture analysis
of HIPPO-TOF neutron diffraction data with MAUD has been
applied to a wide range of samples such as metals �e.g.,
Matthies et al., 2005�, ceramics �e.g., Jones et al., 2005�, as
well as rocks �e.g., Pehl and Wenk, 2005�, including high-
temperature conditions inside a furnace �e.g., Bhattacharyya
et al., 2006; Lonardelli et al., 2007; Wenk et al., 2009�.
These procedures will, no doubt, be further refined, and we

hope that this brief introduction will make texture analysis
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more palatable for uninitiated HIPPO users, as well as users
of other TOF neutron diffractometers. HIPPO is available
through the LANSCE user program, see http://
www.lansce.lanl.gov. Remember the four steps: �1� load the
HIPPO data with the HIPPO Wizard, �2� enter phase �or
phases�, and �3� refine with the Analysis Wizard �Texture�,
�4� export the orientation distribution in E-WIMV, and cal-
culate pole figures in BEARTEX. A sample without major
complexities is finished in 1 to 2 h on an average PC.
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